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1 Introduction

This document provides instructions for using Microsoft Word and associated styles for preparing your thesis or dissertation.  It also will serve as a template containing all of the basic styles you should need.  Chapters are short in order to illustrate different concepts and show multiple chapters at the same time.
Styles
Using styles will make your life much easier.  There are hundreds or thousands of ways that you might want to take advantage of styles but in this template I will only try and include the most important.  This paragraph for example uses the “Body Text” style which is good for all text in the main body of your writing.  You should know it is “Body Text” because it will be identified in the styles drop-down list as shown in Figure 1‑1.

[image: image1.emf]


Figure 1‑1  Selecting a Style in Word
The other important formatting you should consider using styles for are outlined in the next several sections using heading style 3.
1.1.1 Bulleted Lists
Bulleted lists are used to delineate many related objects that are not necessarily related.  The “List Bullet” style is set up for this.  For example we could list specialties within Civil and Environmental Engineering with a bulleted list like this:

· Structures

· Geotechnical

· Transportation

· Water Resources

· Environmental
1.1.2 Numbered Lists

If a list is more sequential then a numbered list is probably a better choice.  For example if I were to list my favorite classes in order of preference I could use the “List Number” style as follows:

1. CEEn 531

2. CEEn 514

3. CEEn 431

4. CEEn 113

1.1.3 Heading Styles

All the headings in this document use a Heading style.  The number (1, 2, 3) denotes the level for outlined numbering as well.  Heading 1 should be used for chapter titles with Headings 2 and 3 to denote sub-parts of each chapter.  You can extend for deeper heading styles if you wish.  Only Heading styles 1 and 2 are accounted for in the table of contents.  You can modify heading styles for spacing, tabs, etc. by using the command View – Styles and Formatting.  Right click on the style you would like to format and click modify.  
1.1.4 Figures

There is a Figure style that should be used each time you insert some kind of Figure.  It will keep indentation, etc. for figures the same throughout your document and also specifies that a Caption styled line follow.
1.1.5 Captions

The “Caption” style is used for defining captions beneath figures and above tables.  There is a section below that discusses inserting captions so that numbering will remain consistent throughout your document.
1.1.6 Body Text

All of the main body text should use the “Body Text” style.
1.2 Remaining Chapters

The followed numbered list explains what will be covered in the different chapters:

5. This chapter is an introduction that covers the basics

6. The next chapter covers figures, tables, captions, and cross references

7. The third chapter covers page numbering, table of contents and the other preliminary pages to the document

8. There is a small Conclusions chapter followed by

9. A chapter for references

10. The appendix provides a little help for preparing your thesis or dissertation for electronic submission

2 Figures, Tables, Captions, and Cross References
If you want to be able to automatically insert/delete tables and figures without having to manually renumber then you will want to take advantage of references for captions and references within your document.  Further, using these styles makes it possible to automatically generate lists of figures and tables as described later.
2.1 Inserting Captions

For figure, table and equation numbers you should use the Insert-Reference-Caption command in Word as shown in Figure 2‑1.
[image: image2.emf]


Figure 2‑1: Inserting a Caption
When inserting a caption you will notice that you can choose between Figure, Table, or Equation as shown in Figure 2‑2.  The important thing about inserting captions in this way is that the numbering will automatically be maintained if you have to insert a new figure someplace in your document.

[image: image3.emf]


Figure 2‑2 Choosing the type of caption

2.2 Cross References
Another reason to insert captions is that you can use the Cross Reference option when you reference your figure, table, or equation from the main body of your document.  Cross references are then automatically updated as well.  However, sometimes I have found that you may want to use Print Preview to make sure all captions and cross references are properly updated as this does not automatically happen when you insert/delete a caption.   Figure 2‑3 shows how you access the Cross Reference option.

[image: image4.emf]


Figure 2‑3 Inserting a Cross Reference
You can then choose what kind of cross reference you are inserting (figure, table, etc.) and whether you want to reference the entire caption or only the number.  I have used only numbers in the examples and find it to be the most useful.
[image: image5.emf]


Figure 2‑4 Cross-reference options
2.3 Tables

The next illustration is for a table.  Note that the table references are the same as the figure so that they are automatically updated. See for example Table 2‑1
Table 2‑1: Curve numbers for associated basins
	Basin Name
	Curve Number
	Minimum
	Maximum

	1B
	68.5
	49.2
	84.1

	2B
	66.2
	46.4
	82.7

	3B
	65.4
	45.5
	82.3

	4B
	65.1
	45.1
	82.1

	5B
	66.6
	46.9
	83.0

	6B
	65.8
	46.2
	82.5

	7B
	69.4
	50.3
	84.6


2.4 Equations

Microsoft Word has an equation editor that can be accessed using the Insert – Object command.  You will have to scroll through the list of Objects in the dialog shown in Figure 2‑5 until you see the Equation object.  Unfortunately the Equation editor is not installed by default with Microsoft Office (I guess they are not scientists at heart) so you may have to get your Office CD and install it through the Custom option if you do not see it.
[image: image6.emf]


Figure 2‑5 Setting up Equations with the Microsoft Equation Editor

While Word’s equation editor is adequate it was kind of more of an after thought.  Still, you will find it useful and further it is also easy to reference (see 2-1) them so that numbering is automatically maintained.  Insert an equation number for your equations, (See Figure 2‑2 and choose Equation).  Word will only allow the equation number above and below equations, figures, and tables.  However, after the caption is inserted, you can move the text to be on the same line with your equations by using a series of tabs after the equation.
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(2‑1)
2.5 Landscape Figures and Tables
A figure or table may be placed horizontally (landscape) on the page with the top at the binding (left) side.  The table title above the table and the figure caption below with their numbers so that they read vertically up the page.  The page number is in its normal position at the bottom center of the page.  When inserting a caption, you must change the text direction as shown in Figure 2‑6.
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Figure 2‑6 Changing the Text Direction for Landscape Figures and Tables
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Figure 2‑7  Landscape Figures and Tables Should have a Caption/Title Vertically on the Page
3 Page Numbering, TOC, Lists, and Signature Pages
This document has been compiled as a single document by taking advantage of sections.  By using sections you can restart (or continue) page numbering and have separate formatting/styles (for example page numbering styles) in different sections.

3.1 Inserting a Section
New sections are created so that you can change the layout or formatting of different parts of the document.  All new chapters in this document have been created by inserting new sections.  This is done by choosing the Insert-Break command.  You will then choose the type of break you want to insert as shown in Figure 3‑1.

[image: image9.emf]


Figure 3‑1 Inserting an “Odd Page” Break to Create a New Section

All of the sections in this document have used the “Odd Page” break type.  This will insure that each new chapter starts with an odd page number.  Odd pages are always on the right hand side of your document and when photocopying two sided that is where you will want each new chapter to begin.  Doing it this way should also force the printer to print a “blank” page if one chapter ends on an odd page so that you will have all the pages necessary to run the document as a one sided to two sided copy job.  This is especially helpful in the preliminary pages.  You can change the break type of any section by putting the cursor in the first page in that section and then choosing Page Setup from the File menu.  From the Layout tab select the type of break to begin the section as shown in Figure 3‑2.

If a blank page is created from using the odd page break, no page number will be printed on the blank page.  However, University standards require page numbers on all pages.  So, once your thesis is finished, and you are ready to print, go to the end of each chapter and make sure you have a page with a page number.  You may have to insert actual page breaks to do this.  This will create an actual blank page with a page number.  See the end of Chapter 3 for an example.  You may find it easier not to use odd page breaks in the text and just add blank pages where needed at the end of chapters to ensure that the next chapter begins on an odd page.
[image: image10.emf]


Figure 3‑2 Changing the Break Type for the Start of a Section.

The Page Setup dialog shown in Figure 3‑2 is also used to control some other important parameters.  For example margins are set by selecting the Margins tab.  Some important things to note about how these properties are set is the setting for Multiple Pages is “Mirror margins” so that there are outside and inside margins rather than left and right since we want the larger margin to always occur on the inside where binding takes place.  For odd pages this is the left, but for even it is the right.
3.2 Page Numbering

The page numbers have been inserted in the footers.  You can view them by choosing the View Headers/Footers command.  You can modify the format by choosing the Page Numbers command from the Insert menu as shown in Figure 3‑3
[image: image11.emf]


Figure 3‑3 Changing Page Numbers

Page numbers have been defined to continue from one section to the next in the main body.  However it is important that you go in and define the starting page for the Table of Contents section since this will vary depending on whether you include an acknowledgments page.  Also I have set it to start at vii by default because while each of the first sections start on Odd Pages (so that blanks will be printed and the document readied for two-sided copying) we don’t want to count those blanks in page numbering as we do in the body of the text.  To set a specific starting value choose the Options button as illustrated in Figure 3‑4
[image: image12.emf]


Figure 3‑4 Page Numbering Options

You will then see the dialog shown in Figure 3‑5 and be allowed to set the “Start at” page number appropriately.

[image: image13.emf]


Figure 3‑5 Defining the Page Number to Start a Section at.
3.3 Signature, Title Page, Abstract, Acknowledgements, and Other Preliminary Pages 
The first few pages of this document are properly formatted for the title page, signatures, abstract, etc.  You should just replace the appropriate areas with your title, your name, your advisor, etc. and it will be ready to print.  The acknowledgements page is optional so if you do not want it you can delete it.
3.4 Table of Contents
There is no need to have table of contents (TOC) entries for pages up to the TOC.  These pages count in terms of the page number the TOC starts on, but they are not listed in the TOC itself.  The entries for the remaining chapters are created automatically when you are finished by choosing the Insert- Reference-Index and Tables command as shown in Figure 3‑6.  This will bring up the dialog shown in Figure 3‑7.
[image: image14.emf]


Figure 3‑6 Generating the Table of Contents

[image: image15.emf]


Figure 3‑7 Table of Contents Options

The default options will generate TOC entries for Heading Styles 1 and 2 (just 1&2), but you will need to choose the Options button and specify the List Title to be level 1 (see Figure 3‑8) in order to have your List of Tables and List of Figures included.
[image: image16.emf]


Figure 3‑8 Defining Styles to be Included in a Table of Contents.
You may also want to turn off Heading Style 3 as I have done for this TOC.  Unfortunately you have to do this each time you generate the TOC because Word doesn’t seem to have a way to remember it from one time it generates the TOC to another (but this isn’t something you have to do all the time either).  There are plenty of other options for the number of levels included in your TOC and other formatting if you want to explore.  You will be prompted if you wish to replace the existing TOC which you should do.  The TOC styles insert a series of periods (……) for tabs so that numbers are right aligned.  This causes some extra periods in the Appendix entries which you will need to delete manually.
Do not run the titles into the page number section.  Modify the layout of the table of contents to include tab stops at the right side if you have titles that are long enough to go to a second line.  You will also want to modify the paragraph style to make entries single spaced if more than one line and double spaced between entries.  This can all be done by modifying the table of contents layout.
3.5 Lists of Figures and Tables

Lists of figures and tables are generated automatically the same way the TOC is created.  Before generating these lists you should put your cursor on the first line of the table/figure list you wish so that it replaces the correct one.  In either case you will choose the List of Figures tabs from the dialog shown in Figure 3‑7.  From this tab you will be able to choose whether or not you wish to generate the list of tables and list of figures.  Remember that in order to generate these lists automatically you must have used the Insert-Reference-Caption option when defining the captions of each table and figure. Long figure/table titles should not run into the page number section.  Titles should end four spaces before the page number.
4 Conclusions
I hope this document will be of use to you.  Undoubtedly you will find “bugs” or problems with it and/or you will discover new/better ways to make your writing more efficient.  Please feel free to make corrections to this template and email it back to me at lynda@byu.edu when you do so that I can pass it on to others.
There is a lot more you can learn about MS that will help and I encourage you to do so.  However, the most important thing to learn is to use Styles and then edit formats through styles so that you do not have to continuously go through your document and update manually when you want to change a font size, spacing, numbering, etc.

One final note of advice is that you shouldn’t be afraid to use the Help option within Word to investigate how different options work.  There were many times in the course of building this template that it was handy and provided me with good information.

Lastly, below is a checklist of things to remember to look for as you review your thesis for formatting:
· Three lines above and below figures, tables, and equations

· Chapters should start on an odd page and have a 2” top margin

· Check numbering of sections, figures, tables, etc. to make sure they are consistent and have not changed.

· Update your TOC, List of Figures, and List of Tables

· Check cross references that they are correct
· Take thesis to your department and then to the dean’s office for formatting review
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Appendix A. Electronic Document Submission
The Fulton College of Engineering and Technology requires all theses and dissertations be submitted electronically.  While you may view this as an unnecessary headache, it is actually quite simple to do and will save you $$$.  

All the information you need to know about creating an electronic document can be found at the university website:  http://etd.byu.edu
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